ПРАКТИЧЕСКАЯ РАБОТА № 11
СОЗДАНИЕ МОДЕЛЕЙ РЕЛЬЕФА В ПРОГРАММЕ SURFER
НАЧАЛО РАБОТЫ В SURFER
После первого запуска Surfer следует убедиться, что в качестве единиц измерения расстояний и размеров внутри Surfer установлены привычные сантиметры, а не задаваемые по умолчанию дюймы. Для этого надо выполнить команду File > Preferences (Файл > Предпочтения). При этом появится диалоговое окно Preferences (Предпочтения). Это окно имеет 4 вкладки. Следует перейти на вкладку Drawing (Рисование). В группе Page Units (Единицы страницы) надо пометить пункт Centimeters (Сантиметры).

Для применения выбранного параметра щёлкнуть по кнопке ОК:
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Главное окно Surfer показано на рисунке ниже. При первом запуске Surfer автоматически создаётся новое пустое окно плот-документа Plot1. Окно плот-документа является тем рабочим пространством, внутри которого можно создавать сеточные файлы и карты, сопровождать их подписями и простыми графическими объектами (полигонами, прямоугольниками, эл​липсами, символами и т. п.).
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Вид окна Surfer при первом запуске в режиме плот-документа: 
1 - заголовок с именем плот-документа; 2 - главное меню; панели инструментов: 3 - «главная» (Main), 4 - «рисование» (Drawing), 5 - «карта» (Map); управляющие линейки (Rulers): 6 - горизонтальная, 7 - вертикальная; 8 - печатная страница; 9 - непечатаемое рабочее пространство; полоски прокрутки: 10 - вертикальная, 11 - горизонтальная; 12 - строка состояния (Status Bar); 13 - менеджер объектов (Object Manager)

Главное меню этого окна содержит следующие пункты:
	File (Файл)
	- команды для открытия и сохранения файлов, печати карт, изменения параметров печати и создания новых документов;

	Edit (Правка)
	- команды для работы с буфером обмена и вспомогательные ко​манды редактирования объектов;

	View (Вид)
	- команды, контролирующие внешний вид текущего окна документа;

	Draw (Рисование)
	· команды для создания текстовых блоков, полигонов, полили​ний символов и фигур;

	Arrange (Упорядочение)
	- команды, контролирующие порядок и ориентацию объектов;

	Grid (Сетка)
	- команды для создания и модификации сеточных файлов;

	Map (Карта)
	· команды для создания и модификации карт;

	Help (Справка)
	· обеспечивает доступ к справочной службе.


Когда активно окно плот-документа, в главном окне Surfer имеется три панели инструментов: Главная (Main), Рисование (Drawing) и Карта (Map).

[image: image3.emf]
Панель инструментов Main (Главная)
[image: image4.emf]
Панель инструментов Drawing (Рисование)
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Панель инструментов Map (Карта)
Большую часть окна плот-документа занимает печатная страница. При отправке на принтер создаваемых в Surfer изображений обычно печатается только то, что помещается внутри этой страницы. Слева от печатной страницы находится менеджер объектов. Если при первом запуске Surfer менеджер объектов отсутствует, то следует выполнить команду View > Object Manager (Вид > Менеджер объектов) или нажать на кнопку [image: image6.png]


 на панели инстру​ментов Main (Главная). Менеджер объектов – это важный инструмент управления соз​даваемыми в окне плот-документа изображениями. Без него нельзя обойтись в том случае, когда создаётся оверлей (т. е. наложение одной на другую) не​скольких карт.
Создание XYZ-данных

Построение любой карты в Surfer обычно начинается с подготовки фала, содержащего XYZ-данные. XYZ-данные - это, как правило, числовая информация, состоящая из не менее чем трёх столбцов, первые два из ко​торых чаще всего рассматриваются как аргументы X и Y, а третий (или ос​тальные) - как функция (функции) Z этих аргументов.

Не допускается делать пропусков при вводе таких данных, т. е. для каждой пары значений X и Y обязательно должны присутствовать значения всех функций Z. В первой строке для каждого столбца можно задавать ко​роткие текстовые комментарии.
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Вид окна Surfer в режиме рабочего листа: 1 – заголовок с именем файла с данными; 2 – главное меню; 3 – панель инструментов «главная» (Main); 4 –строка адреса ячейки; 5 – строка редактирования содержимого ячейки; 6 – кнопка выделения всей таблицы; заголовки: 7 – столбцов, 8 – строк; 9 – активная ячейка; 10 – таблица рабочего листа; полоски прокрутки: 11 – вертикальная, 12 – горизонтальная; 13 – строка состояния (Status Bar)
Для того чтобы открыть готовый файл Tutorws2.dat (это один из примеров, поставляемых в комплекте Surfer, находится в папке Surfer 8 > Samples) с XYZ-данными в отдельное окно рабочего листа необходимо:

1. Выполнить команду File > Open (Файл > Открыть) или использовать кнопку «Открыть» на панели инструментов Main. Появится стандартное диалоговое окно Open (Открыть).

2. В списке файлов выбрать Tutorws2.dat и щёлкнуть по кнопке Открыть. Имя этого файла появится в заголовке окна рабочего листа.

3. Можно видеть, что в столбце A находятся значения координат X (Easting, Восточное положе​ние), в столбце B - значения координат Y (Northing, Северное положение), а столбце C - значе​ния Z (Elevation, Высота). Текст заголовков столбцов (текст в строке 1) не является обязатель​ным, но помогает идентифицировать тип данных в столбцах. Кроме того, эта информация ис​пользуется в разных диалоговых окнах, где требуется выбирать столбцы рабочего листа.
Главное меню окна рабочего листа содержит следующие пункты:

File (Файл)
- команды для открытия и сохранения файлов, печати;

Edit (Правка)
- работа с буфером обмена и другие вспомогательные команды;

Format (Формат)
- установка формата ячеек, ширины столбцов и высоты строк;

Data (Данные)
- команды для сортировки данных, вычисления статистических характе​ристик и выполнения математических трансформаций;

Window (Окно)
- команды для управления дочерними окнами;

Help (Справка)
- обеспечивает доступ к справочной службе.

Создание и сохранение нового файла с XYZ-данными

Surfer позволяет создавать новые файлы с данными. Для этого:

1. Выполнить команду File > New (Файл > Создать) или использовать кнопку Создать на панели инструментов Main. Появится диалоговое окно New (Новый). Если выбрать пункт Worksheet (Рабочий лист) и щёлкнуть по кнопке ОК то появится новое пустое окно рабочего листа.
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Окно New (Новый) предоставляет выбор для создания плот-документа или рабочего листа
2. Структура таблицы в Surfer схожа с таблицей Excel, работать в ней и вводить данные можно аналогично.

3. После окончания ввода всех данных необходимо выполнить команду File > Save (Файл > Сохранить) или использовать кнопку Сохранить на панели инструментов Main. Если файл с данными до этого ещё не сохранялся, то появится диалоговое окно Save As (Сохранить как). В выпадающем списке Save File as Type (Тип файла) выбрать пункт Golden Software Data (*.DAT).
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4. Ввести имя файла в строке File name (Имя файла). 4. Щёлкнуть по кнопке Save (Сохранить). Появится диалоговое окно GSI Data Export Options (Параметры экспорта данных), которое позволяется выбрать, каким образом будет отформатирован сохраняемый файл. Те параметры, которые стоят по умолчанию, вполне подходят для большинства случаев, поэтому менять их следует, только если в этом есть конкретная необходимость.
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5. После щелчка по кнопке файл будет сохранён в формате Golden Software Data (*.DAT) с указанным именем. Это имя появится наверху окна рабочего листа.
Для создания интерполированной регулярной сетки в Surfer (основа для всех последующих манипуляций в этой программе), нужно иметь заранее подготовленные данные в виде тройки значений X/Y/Z (x/y – координаты точки,  z – значение параметра z в данной точке), представленные в одном из популярных форматов (например, .txt, .xls, .mdb и т.д.). (Для решения данной задачи (построение модели рельефа местности в Surfer) наиболее оптимальным способом получения входных данных будет, наверно, метод их экспорта из ГИС-пакетов. Набивка вручную данных по горизонталям может оказаться слишком трудоёмкой задачей. А векторный редактор Surfer не самый удобный).
Далее идём меню  Grid > Data (Сетка координат > Данные):
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Выбираем нужный формат представления данных (файл .txt в приведённом примере) и далее ищем нужный файл:
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Затем следует форма настройки параметров интерполяции (выбор метода, размера сетки, указание выходного файла и т.д.):
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В разделе Data Columns указано, сколько именно точек в открываемом файле (в данном примере их 3065 – 3065 data points), а также из каких колонок таблицы брать данные для координат X и Y, а также значение параметра Z (по умолчанию предлагаются соответственно колонки А, В и С).

В разделе Метод Генерирования Сетки выбирается, с помощью какого метода будет построена сетка (обзор этих методов в документе Методы построения сети в программе Surfer).

В разделе Файл сетки вывода выбирается название нового грид-файла с расширением .grd и папку, в которой он будет сохранён.

Если поставлена галочка в пункте Отчёт о сетке, то после создания файла на экран будет выведен документ, содержащий разнообразную статистическую информацию о данных, содержащихся в файле, в таком виде:
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Для продолжения жмём кнопку OK.
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Файл сетки в формате программы Surfer .grd успешно создан.
Теперь на основе этой сетки строим пробную карту. Пусть это будут изолинии – меню  Map > Contour Map > New Contour Map (Карта > Карта горизонталей > Новая карта горизонталей):
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... и выбираем нужную сетку:
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Жмём кнопку Открыть. После этого программа приступит к построению карты изолиний. Результат (как пример для построения рельефа) может выглядеть следующим образом:
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На рисунке выше виден существенный недостаток такой карты – программа провела интерполяцию в "пустых" областях (обозначено красным). Стоит задача как-то избавиться от них. В  Surfer'е эта проблема решается с помощью так называемых "бланкованных" карт. 
В программе Surfer имеется возможность при выводе скрывать часть ячеек ГРИДА (Grid). Для этой цели предусмотрено специальное значение (Blanking value), равное 1.70141е+38, которое присваивается тем ячейкам ГРИДА, которые необходимо скрыть. Surfer не учитывает эти значения при математических операциях с ГРИДАМИ (в том числе при вычислениях объема и площади) и при их визуализации. Программа «считает», что в данной ячейке значение отсутствует. Для простоты процедуру присвоения ячейкам ГРИДА значений 1.70141е+038 (Blanking value) будем называть «бланкированием». 

Подобная процедура может понадобиться для удаления (скрытия) тех частей ГРИДА (карты), которые были рассчитаны либо в области от-сутствия скважин, либо с целью выделения определенного участка карты. 

Поскольку ячейки ГРИДА (карты) в процессе бланкирования не удаляются, то соответственно размерность карты (количество ячеек по оси Х и Y) остается без изменений. 

В программе Surfer существует несколько способов присвоения ячейкам карты бланкированных (Blank) значений. Наиболее часто эта задача решается с использованием меню Grid>Blank. 

Для задания области ГРИДА, в которой ячейкам будет присваи-ваться значение «отсутствия данных», существует специальный файл формата [.BLN] (blanking file). Это обыкновенный текстовый файл формата ASCII, который можно создавать как в таблице WorkSheet, так и в обычном текстовом редакторе. Файл состоит из двух столбцов. В первой строке первого столбца этого файла указывается количество узлов, из которых состоит полигон (область бланкирования). Во втором столбце первой строки записывается значение 0 или 1 («флаг»). В слу-чае, когда в качестве «флага» использован 0 бланкируются значения ГРИДА, расположенные вне полигона в противном случае значения Blank присваиваются ячейкам, лежащим внутри полигона. В после-дующих строчках указываются координаты узлов полигона. Их количе-ство должно соответствовать значению, указанному в первой ячейке таблицы. Полигон для бланкирования должен быть обязательно замк-нут, т. е. координата последнего узла должна совпадать с координатой первого. Файл *.bln автоматически создается при выполнении меню Map>Digitize. Следует помнить, что по умолчанию при генерации фай-ла *.bln в качестве «флага» заносится значение 1.
Делается это следующим образом. Становимся в Менеджере объектов на карту и по правой кнопке мыши выбираем пункт Digitize в контекстном меню:
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... и начинаем мышкой обходить по контуру область, которую хотим исключить из интерполяции (красные крестики на рисунке ниже):
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По окончании обводки на форме Digitized Coordinates в меню File>Save As (Файл > Сохранить как) сохраняем бланкованную область в виде файла с расширением .bln . 

Далее нам необходимо построить новую интерполированную сетку, с учётом «пустых» областей. Для этого идём в меню Grid > Blank (Сетка координат > Пустоты):
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...  загружаем исходную (не обрезанную) сетку:
[image: image24.png]- Open Grid

Mo | [ _sur

Viun

Lara wswenenns

Tun

|Eidwgrd

17.002011 11:40

Grapher 6

out.grd

Elpointsard

17.002011 11:40
17002011 1131

Vo, Ceorwon>>

Grapher G
Grapher 6





... и область обрезки - файл с расширением bln
[image: image25.png]- Omcperms

RN =N = =:d

Hara wwenenns  Tun
121120131952 Oaiin "B





Сохраняем полученную таким образом новую сетку:
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Появляется сообщение об успешном бланкировании файла:
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Делаем пробную карту и смотрим результат:
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Вот теперь всё нормально. Исключили из результатов интерполяции лишние области. Теперь можно двигаться дальше.

Строим карту с отмывкой - меню Map > Shaded Relief Map (Карта > Оттенённая карта рельефа):

[image: image29.png]- Surfer - [Ueprexd]

e —————

DEsEES &8 = N s TAKRAR TN FoDoO

R R O e W R W R M R W N

Map =
Right Ads
Left A
Top A
Bottom
Shaded Relief
Map

Right Ads
Left A
Top A
Bottom
Contours

5750000

5700000

5650000

5600000

5550000

5500000

5450000

5400000

5350000

750000 800000 850000 900000 950000 1000000 1050000 1100000 1150000




Видим недочёт – бланкованные области залиты чёрным. Сейчас выправим этот недостаток. В Менеджере объектов двойным щелчком щелкаем на карту рельефа (Shaded Relief) и на вкладке General (Общие) идём в раздел Missing Data (Отсут. Дан.) и выбираем цвет заливки для областей с отсутствующими данными белым: 
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Получилось: 
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Карта стала немного симпатичней. Теперь в Менеджере объектов поднимем слой с изолиниями выше слоя-отмывки и в свойствах слоя (вызывается двойным щелчком на слое в Менеджере объектов) во вкладке General (Общие) выставляем опцию Fill Contours (Заполнить контуры). Жмём ОК:
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Следующий шаг - придаём нашей карте более привлекательный цветной вид. Цветная заливка, так же как и параметры линий, может быть применена к отдельным уровням (отрегулировать стиль каждой изолинии [например, изолинии круглых значений сделать более жирными и т.п.] и заливки между двумя изолиниями можно во вкладке Levels (Уровни) окна свойств слоя. В то же время ко всем уровням сразу можно применить цвета, основанные на градиентном спектре (плавном переходе) между двумя задаваемыми цветами. Для этого необходимо щелкнуть на заглавие колонки Fill во вкладке Levels (Уровни) и выбрать желаемый основной цвет:
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Карты будет выглядеть так (для вывода шкалы легенды необходимо выбрать галочкой пункт Цветовая шкала во вкладе Общие):
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Можно раскрасить каждый промежуток между изолиниями вручную, последовательно щёлкая на каждом из них и выбирая желаемый цвет:
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Карта может выглядеть так:
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Или так:
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Также в свойствах слоя изолиний можно задавать интервал между изолиниями, частоту и шрифт подписей изолиний и т.д.
В свойствах слоя оттенённой карты рельефа можно выбрать цвет, указать вертикальный и горизонтальный углы наклона солнца, чтобы выяснить как выглядеть модель рельефа при различном солнечном освещении:

[image: image38.png]Macuras | Mpegens: | Background

Benanorar. Maparerpel
Mozt Meron
Beprucan: 50 5 | Uesmpaneroe Paonrure -

Meron Jarenervis
Orpanene Lamberian +

2 Macus Koo 17.3270283

oK Orverre

||

[





КАК В SURFER НАНЕСТИ КООРДИНАТНУЮ СЕТКУ

Нанести координатную сетку на карту в Surfer совсем не трудно. Пусть исходная карта выглядит следующим образом:
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Для отображения координатной сетки на карте в Менеджере объектов двойным щелчком щелкаем на Left Axis (Левая Шкала) и вызываем диалоговое окно Map: Left Axis Properties.

Во вкладке Линии сетки ставим галочку на пункт «Показать основные линии сетки»:
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Задать стиль линиям можно, нажав на кнопку и изображением линии (снизу от пункта «Показать»):
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Чтобы поменять шаг сетки, сбрасываем флажок в опции Automatic (Автоматическое масштабирование) на вкладке  Scaling (Масштабирование)  и в Major interval (Главный интервал) задаём новое значение:
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Аналогичную процедуру повторяем с пунктом Bottom Axis (Нижняя Шкала) в Менеджере объектов. В результате на карте появится сетка:

[image: image44.png]



Размер, шрифт, угол, величину смещения и другие параметры подписей к осям можно задать во вкладке General (Общие) диалоговых окон Map: Left Axis Properties и Map: Bottom Axis Properties (нажатием кнопки «Шрифт» вызывает окно «Свойства текста»):
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Остался ещё один момент. Желательно нанести подписи к изолиниям. Для этого в окне свойств слоя выбираем вкладку Levels (Уровни) и щелкаем по заглавию колонки Label. В пункте Font (Шрифт) выбираем стиль подписи, а в пункте Format (Формат) – её формат.
Следуем далее – жмём правой кнопкой на слой изолиний в менеджере объектов и в выпадающем контекстном меню выбираем Edit Contour Label. Теперь прижимая Ctrl, тыкаем курсором в нужную изолинию. Программа нанесёт на карту метку значения уровня контура.
КАК В SURFER СОЗДАТЬ 3D-КАРТУ
Чтобы создать 3D-карту в Surfer, вам необходимо иметь  интерполированную регулярную сетку – файл с расширением .grd. О том, как его создать – в документе «Как в Surfer создать файл интерполированной регулярной сетки .grd».

Идём в меню Map > Surface (Карта > Поверхность), выбираем нужный файл сетки grd и видим результат (как пример):
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В некоторых случаях, масштаб карты по оси Z выглядит не всегда пропорциональным (как на приведённом выше рисунке). Чтобы выправить это недостаток в Менеджере объектов разворачиваем меню Map и двойным щелчком  на название 3D Surface вызываем диалоговое окно Map: 3D Surface Properties и на вкладке Scale (Масштаб) уменьшаем значение параметра Length (Длина) для Z координаты:
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Результаты видим на рисунке:
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Вот теперь созданная 3D-поверхность смотрится более приемлемо.
Совмещать различные карты можно выбрав последовательно в менеджере объектов те из них, которые необходимо совместить (удерживая Shift), затем выбрать команду Карта > Совмещение карт (Map > Map Overlay). 

Домашнее задание. Создать карты поверхности различных типов, совместить их всеми возможными способами. Результаты последовательно копировать в  Word. Документ Word с изображениями сдать преподавателю.
